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Tato příručka vznikla po mnoha desítkách hodin strávených u překladu textů, při zkoušení a ověřování 

postupů v programu DaVinci Resolve Studio. 
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1. ZÁKLADNÍ NASTAVENÍ DAVINCI RESOLVE  

1.1 PROJECT MANAGER   

Pro většinu uživatelů je Project Manager  (Správce projektů)  

prvním oknem, které uvidí, když otevřou program DaVinci 

Resolve.  

Project Manager je centralizované rozhraní pro správu všech 

projektů patřících uživateli.  

Project Manager  je také místem, kde importujete a exportujete 

projekty do a z DaVinci Resolve, ať už přesouváte projekty od 

uživatele k uživateli, nebo přesouváte projekty z jedné pracovní 

stanice DaVinci Resolve na druhou.  

Project Manager vám rovněž umožní uspořádat databáze 

pomocí postranního panelu databáze. 

➢ Otevřete DaVinci Resolve Studio (spusťte program). 

➢ Pokud máte již DaVinci Resolve otevřený, zvolte cestu přes 

položku hl. menu File > Project Manager nebo klv. zkr. Shift+1 

nebo přes ikonu „domečku“, v pravém dolním rohu okna 

programu DaVinci Resolve.  

➢ Spustíte tedy Project Manager! 

Project Manager se otevře s miniaturami, které představují vaše 

předchozí projekty.  

➢ Teď budete pracovat s novým projektem, proto otevřete 

nový projekt tlč. New Project a pojmenujte si jej.  

➢ Poté stiskněte tlč. Create (Vytvořit).  
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Pokud máte po předchozí práci změněnou polohu a rozmístění 

panelů, uveďte vše do původního nastavení přes položku hl. menu 

Workspace > Reset UI Layout.  

V okně Projects Manager si můžete řadit projekty do složek.  
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Přes prv. tlč. myši vyvoláte kontextové menu, kde 

zvolte nabídku New Folder… (Vytvořit adresář) a tento 

si přejmenujte dle vlastní volby. 

K vložení projektů do nových adresářů můžete použít 

přetažení myši nebo přes prv. tlč. myši vyvoláte 

kontextové menu, zvolte položkou Cut a Paste 

(Vyjmout a vložit).  

Přejmenování projektů provedete přes kontextové 

menu, tj. klikněte prv. tlč. myši na původním názvu a zvolíte položku 

Rename… . 

Pokud aktivujete levý panel Project Manager ikonou „rozděleného 

okna“ vlevo vedle nápisu Projects, můžete všechny svoje projekty  

zálohovat.  

Tato činnost je vhodná před každou aktualizací programu.  

Zálohování provedete tlč. Backup. 

Po kliknutí na ikonu si vyberete místo na disku a provede zálohu 

všech svých projektů. 

Pozor, jde pouze o zálohování virtuálních souborů projektu – 

časové osy, virtuální adresáře, nastavení. Všechno krom médií!  

Pokud chcete archivovat i média v projektu, tj. 

fyzicky kopírovat MB či GB svých dat, musíte prv. tlč. 

myši na daném projektu, přes kontextové menu, 

vybrat volbu Export Project Archive… a dále musíte 

vybrat místo na disku a zda chcete archivovat i 

Optimized Media (Optimalizovaná média) a Render 

Cache (Předrenderované soubory).  
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1.3 PROJECT PREFERENCES - PŘEDVOLBY PROJEKTU  

Okno Project Preferences (Předvolby projektu) 

je rozdělené na panely System a User 

(Systémové předvolby a Uživatelské 

předvolby). 

Umožňuje vám nastavit celkové prostředí 

programu DaVinci Resolve, zvolit jaký 

hardware používáte s DaVinci Resolve a jaké 

nastavení uživatelského rozhraní při práci 

preferujete. 

Volba hl. menu DaVinci Resolve > Preferences, nebo klv. zkratka 

Ctrl+, (Ctrl + čárka). 

INDIVIDUÁLNÍ PREFERENCE A NASTAVENÍ ZALOŽENÉ NA 

PŘIHLÁŠENÍ 

Od verze DaVinci Resolve 16 existují individuální předvolby a 

nastavení pro každý přihlašovací účet v daném počítači.  

To znamená, že každý člověk může mít své vlastní 

přihlašovací údaje k operačnímu systému a DaVinci Resolve bude 

udržovat samostatné rozvržení pracovního prostoru a předvolby pro 

každého umělce v závislosti na tom, kdo je přihlášen.  

OBNOVENÍ PŘEDVOLEB 

Obnovení všech předvoleb na výchozí hodnoty je 

jednoduché. 

➢ Klikněte myší v pravém horním rohu okna na 

volbu (…) a vyberte Reset System 

Preferences…. 

 

SYSTEM PREFERENCES  - SYSTÉMOVÉ PŘEDVOLBY  

Systémové předvolby vám umožňují konfigurovat 

hardware, se kterým DaVinci Resolve pracuje. 

Pokud máte systém, který se příliš často nemění, můžete 

okno Project Preferences použít jen zřídka. 

Na druhou stranu, pokud pracujete s mobilním systémem se 

změnou videorozhraní, ovládacích panelů a pomocných svazků, 

můžete toto okno používat častěji. 

Kdykoli změníte některá základní nastavení systému v předvolbách, 

bude pravděpodobně nutné ukončit a restartovat DaVinci Resolve, 

aby se tyto změny projevily. 
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MEMORY AND GPU - KONFIGURACE HARDWARU 

Umožňuje vybrat různé možnosti, jak se 

řídí použití GPU připojených k vašemu 

počítači a jak konfigurovat prohlížeče 

na různých stránkách.  

Tento panel také poskytuje přehled 

všech referencí o všech hardwarových a 

počítačových charakteristikách, které 

jsou důležité  pro bezproblémový běh 

DaVinci Resolve, včetně seznamu 

nainstalovaných GPU. 

Horní část tohoto panelu poskytuje možnosti konfigurace paměti, 

zatímco spodní část tohoto panelu poskytuje ovládací prvky pro 

zpracování GPU. 

➢ Memory and GPU 

• System Memory: Zde je uvedena celková dostupná RAM na 

vaší pracovní stanici. 

• Limit Resolve memory usage to: Tato předvolba omezuje 

celkové množství systémové paměti, které používá DaVinci 

Resolve, čímž udržuje paměť dostupnou pro jiné aplikace. 

Maximální a výchozí nastavení této předvolby je 75 procent 

paměti RAM vašeho systému. 

• Limit Fusion memory cache to: Umožňuje omezit, kolik 

paměti RAM smí mezipaměť pro „přehrávání“ na záložce 

Fusion používat. V závislosti na délce klipů, na kterých na 

záložce Fusion pracujete, může mezipaměť přehrávání 

zabírat značné množství dostupné paměti. Hodnota, kterou 

zde přidělíte, je převzata z celkového množství paměti 

přiděleného nastavením Limit Resolve memory usage to.  

➢ GPU Configuration: V této části můžete zvolit jak má být 

pracováno s GPU. 

➢ GPU processing mode: Umožňuje nastavit DaVinci Resolve 

tak, aby pro zpracování efektů používalo výpočetní API 

OpenCL, CUDA nebo Metal GPU. Který je nejlepší, závisí na 

GPU, a které funkce jsou nainstalovány ve vašem počítači. 

Většina uživatelů může tuto sadu nechat na Auto, aby si 

DaVinci Resolve vybralo co je vhodné. Jinak jsou zde 

konkrétní doporučení. Pokud máte systém macOS, měli 

byste použít Metal. Uživatelé Linuxu a Windows s GPU AMD 

by měli používat OpenCL. Uživatelé systémů Linux a 

Windows s GPU Nvidia by měli používat CUDA, ale ujistěte 

se, že máte správné ovladače pro váš systém a že máte 

nainstalovanou nejnovější aktualizaci CUDA. 

➢ GPU selection mode: Umožňuje vám vybrat mezi Auto, 

které umožní DaVinci Resolve vybrat, které z dostupných 
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GPU ve vašem počítači se mají použít ke zpracování a 

Manual, které vám umožní vybrat, které GPU povolit nebo 

zakázat pro zpracování ze seznamu, který se zobrazí níže. To 

může být užitečné v případech, kdy máte v počítači 

nainstalováno více GPU a chcete ke zpracování vybrat pouze 

nejvýkonnější GPU. Může to být také užitečné v případech, 

kdy je externí eGPU připojen k notebooku nebo zařízení all-

in-one se slabším GPU, takže si můžete zvolit výkonnější 

eGPU pro zpracování. 

➢ GPU selection list: Tento seznam se zobrazí pouze, pokud je 

režim zpracování GPU nastaven na OpenCL, CUDA nebo 

Metal a když není režim výběru GPU nastaven na Auto. 

Zobrazí se seznam všech GPU nainstalovaných ve vašem 

počítači a můžete použít zaškrtávací políčka nalevo od 

každého GPU k povolení nebo zakázání použití konkrétních 

GPU ke zpracování. 

➢ Optimized Viewer Updates: Zobrazí se pouze v systémech 

macOS a Windows s více GPU nebo v systémech Linux s 

jedním a více GPU; umožňuje rychlejší výkon přehrávače 

v DaVinci Resolve. 

 

MEDIA STORAGE - ÚLOŽIŠTĚ MÉDIÍ  

Tento panel umožňuje definovat odkládací 

disk a další umístění úložiště médií 

používaná programem DaVinci Resolve. 

Stejně tak definuje výchozí umístění 

adresářů mezipaměti, která se mají použít 

při vytváření nových projektů. 

 

➢ Media Storage Locations: Tento 

seznam umožňuje definovat odkládací disk systému. První 

svazek v tomto seznamu je místo, kde jsou uloženy statické 

snímky a soubory mezipaměti, takže se ujistěte, že jste vybrali 

nejrychlejší svazek úložiště, ke kterému máte přístup. 

➢ Automatically display attached local and network storage 

locations: Toto zaškrtávací políčko ve spodní části okna 

umožňuje DaVinci Resolve přistupovat k médiím na všech 

dočasně a trvale připojených svazcích, včetně SATA a eSATA, 

SAS, USB, FireWire, Thunderbolt, Gigabit Ethernet (GbE nebo 

GigE), Fibre Channel a jinak připojených pevných disků, aniž 

byste je museli přidávat do tohoto seznamu. Toto je ve výchozím 

nastavení zapnuto. 
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2. ROZHRANÍ DAVINCI RESOLVE 

2.1 INTERFACE PAGES  - ROZHRANÍ ZÁLOŽEK  

DaVinci Resolve je organizováno jako řada záložek  - Media, Cut, 

Edit, Fusion, Color, Fairlight, a Deliver - které odpovídají pořadí 

nejběžnějších postprodukčních pracovních postupů pro video. 

Ke každé záložce se dostanete kliknutím na jedno ze sedmi 

tlačítek ve spodní části obrazovky, pod shodnými názvy. 

Pokud některou uvedenou část nepoužíváte, lze předmětnou 

záložku vypnout přes hl. menu Workspace > Show Page > 

odškrtnout položku, kterou nechcete zobrazovat. 

Pokud kliknete prv. tlč. myši kdekoli na liště (Resolve Page Bar) ve 

spodní části uživatelského rozhraní DaVinci Resolve, zobrazí se 

kontextové menu s dvěma nabídkami: 

Show Icons and Labels a  Show Icons Only  

(Zobrazit ikony a popisky  a  Zobrazit pouze 

ikony).  

Pokud zobrazíte pouze ikony, lišta dole 

zabere méně místa. 

Záložky z lišty můžete i vybírat pomocí 

klávesových zkratek, případně volbou v hl. menu Workspace > 

Switch to Page a dále výběrem v podmenu. 

 

POPIS ZÁLOŽEK 

Media 

➢ Je primárním rozhraním pro import klipů, správu médií a 

organizaci klipů. Pro fungování DaVinci Resolve je zásadní, že 

originální  média použitá v projektu jsou organizována odděleně 

od dat projektu, která importujete a spravujete na záložce Edit. 

Tímto způsobem můžete snadno spravovat a aktualizovat klipy 

používané na časové ose v aktuálním projektu, přepínat mezi off-

line a online médii, reorganizovat klipy a řešit problémy, které se 

vyskytnou. Záložka Media je rozdělena do šesti různých oblastí, 

jejichž cílem je usnadnit hledání, výběr a práci s médii ve vašem 

projektu. Většinu funkcí a většinu příkazů najdete v kontextových 

nabídkách, které se zobrazí po kliknutí prv. tlč. myši na klipy v 

knihovně, přehrávači souborů nebo zásobníku médií. 
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Cut 

➢ Záložka Cut je zaměřená jako prostředí pro rychlé úpravy. Je to 

užitečné v situacích, kdy potřebujete rychle vystřihnout segment 

zpráv, vytvořit epizodu webového obsahu, upravit přímočarý 

klip, experimentovat s více uspořádáními scény nebo sestavit 

první hrubý sestřih projektu. Záložka Cut je také dobrým 

úvodním editačním rozhraním pro lidi, kteří s editací začínají, 

protože představuje přehlednou sadu nástrojů, které se rychle 

učí a snadno se používají. Ať je vaše zaměření  jakékoli, záložka 

Cut bude cenným doplňkem vašich editačních zkušeností v 

DaVinci Resolve. Výchozí pracovní prostor záložky  se skládá z 

Media Pool (Prohlížeč médií), Single Viewer (Přehrávač klipů) a 

Timeline (Časová osa). Tyto tři oblasti vám umožňují rychle 

importovat a organizovat klipy, upravovat klipy a dokonce 

exportovat výsledek. 

Edit 

➢ Záložka Edit obsahuje všechny profesionální nástroje pro 

úpravy, které budete potřebovat k sestavení projektu, přidání 

titulků, přechodů, efektů atd, včetně všech detailních nastavení. 

Záložka je rozdělena do tří hlavních oblastí: Media Pool 

(Prohlížeč médií), Source/Offline s  Timeline Viewers 

(Přehrávač klipů/offline a časové osy) a Timeline (Časová osa), 

které společně fungují a umožňují vám importovat, upravovat a 

ořezávat časové osy pomocí flexibilní škály nástrojů. 

Fusion 

➢ Záložka Fusion je komplexní aplikace pro 2D a 3D tvorbu 

vizuálních efektů a pohybové grafiky. V minulosti fungoval 

pouze jako samostatný program. V současné době je Fusion již 

plně zakomponovaný do programu DaVinci Resolve, umožňuje 

okamžitě přejít z editace přímo do kompozice, aniž byste museli 

svou práci exportovat, znovu propojovat soubory nebo spouštět 

jinou aplikaci. Všechno, co nyní potřebujete, je přímo v DaVinci 

Resolve. 

 

Color 

➢ Záložka Color  obsahuje prvotřídní nástroje pro korekci barev a 

kreativní nástroje pro třídění barev, efekty klíčování, stabilizace 

a filtrování. Původně byl DaVinci Resolve pouze korekční 

software pro úpravu barev. Později se tvůrci rozhodli z něj 

vytvořit plnohodnotnou video střižnu se všemi uvedenými 

integrovanými doplňky. 



 

    

Rozhraní DaVinci Resolve 

 

2 

DAVINCI RESOLVE STUDIO 17 | ČESKÝ NÁVOD PRO ZAČÁTEČNÍKY 

Fairlight 

➢ Záložka Fairlight je komplexní digitální zvukový pracovní nástroj, 

která obsahuje vše, co potřebujete k profesionálnímu 

zpracování zvukových stop svého díla. 

Deliver  

➢ Na záložce  Deliver můžete zpracovávat výstup na pásku, 

vytvářet soubory pro web a dokonce exportovat soubory ve 

vysokém rozlišení pro divadelní či filmovou distribuci. Zde 

zpracujete kompletní výstup z DaVinci Resolve.  

Mezi výše uvedenými záložkami se můžete volně pohybovat, 

importovat a spravovat média, upravovat je na časové ose, vytvářet 

vizuální efekty, korigovat barvy, míchat zvuk a finalizovat výstup.  

Mnoho stejných funkcí lze   provádět na různých záložkách a je jen 

na vás, jaký efektivní postup využijete. 

 

2.2 ROZHRANÍ DAVINCI RESOLVE  

Rozhraní DaVinci Resolve se na první pohled nemusí zdát příliš 

uživatelsky přívětivé. 

Ve skutečnosti existuje mnoho způsobů, jak můžete přizpůsobit 

panely ze záložek vašim konkrétním potřebám. 

 

CELÁ OBRAZOVKA VS. PRÁCE V  OKNĚ 

V závislosti na tom jak chcete 

pracovat, můžete zvolit práci s 

DaVinci Resolve v plovoucím okně 

s horním stavovým pruhem. 

Stavový pruh lze změnit, přesunout, 

minimalizovat a použít společně s 

ostatními okny.  

Nebo můžete zvolit položku v hl. menu  Workspace > Full Screen a 

přepnout DaVinci Resolve do režimu celé obrazovky, kde zmizí 

stavový pruh  a DaVinci Resolve zabírá celý rozměr displeje vašeho 

počítače.  

Volba je na vás. 
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ZVÝRAZNĚNÍ AKTIVNÍCH PANELŮ 

Každá záložka DaVinci Resolve se skládá z několika panelů.  

Všechny panely obsahují ovládací prvky a informace nezbytné pro 

konkrétní aspekt funkčnosti dané záložky. 

Každý z panelů má samostatné ovládací prvky, ale všechny se 

zobrazují v hlavním okně uživatelského rozhraní DaVinci Resolve.  

Každý panel, který používáte je „aktivován“, což znamená, že 

kliknutím na položku nebo ovládací prvek v konkrétním panelu se 

tento panel stane aktivním panelem. 

Panel slouží k směrování klávesových zkratek, které jsou sdíleny 

mezi mnoha panely, na konkrétní panel, který aktuálně používáte.  

Pokud chcete vidět graficky zvýraznění, který panel je aktivovaný, 

můžete zaškrtnout volbu  Show focus indicators in the User 

Interface  (Zobrazit indikátory zaostření v uživatelském rozhraní) 

přes volbu  hl. menu  DaVinci Resolve > Preferences  > Settings > 

záložka User  > volba Show focus indicators in the User Interface.  

Když je tato volba zapnutá, červená čára v horní části aktivního 

panelu označuje, že je panel aktivní. 

Jde o praktickou vizuální pomůcku, abyste se lépe orientovali v 

prostředí DaVinci Relove, zejména pokud s tímto programem 

začínáte. 
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3. ZÁLOŽKA MEDIA  

3.1 MEDIA 

 

 

 

 

 

 

 

 

Záložka Media vám poskytuje maximální flexibilitu a funkčnost při 

importu médií (zvukové soubory, video soubory, obrázky atd.) z 

vašich pevných disků a adresářů.  

Budete zde také provádět další úkoly, jako je správa médií a 

organizace klipů, metadat, synchronizace zvukových a videoklipů. 

Tato záložka je i vhodná pro odstraňování problémů s klipy, u 

kterých  se např. neočekávaně zobrazují off-line miniatura, tj. 

ztráta obsahu klipu. 
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3.2 IMPORTOVÁNÍ KLIPŮ  

Když jste připraveni importovat klipy do projektu, 

nejefektivnější způsob je prostřednictvím Media Pool 

(prohlížeče knihovny médií), vlevo nahoře,  kde provedete 

výběr.  

V tomto okně můžete přejít na libovolnou složku nebo 

pevný disk,  na kterém ukládáte média a prostým 

označením vybraných  klipů nebo složek (Shift+levé tlč. 

myši, Ctrl+levé tlč. myši nebo Ctrl+A atd.) je pak myší 

přetáhnete do prostoru zásobníku médií dole.  

Další možností je přes prv. tlč. myši a volbou v 

kontextovém menu Add into Media Pool. 

Nebo volte z menu Edit > Select All,  a vyberete všechny 

klipy zobrazené v knihovně. 

V  Media Pool se pohybujete ve složkách obdobně, jako ve 

svých složkách ve Windows.  

Pokud potřebujete více prostoru pro výběr ze složek, klikněte na 

ikonu šipky a prohlížeč se otevře přes celou levou stranu programu.  

Opětovným kliknutím výběr zmenšíte do původní velikosti. 

Když importujete klipy do projektu, jsou uloženy v zásobníku pro 

vybraná média daného projektu jako virtuální soubory, pokud je 

chcete ze zásobníku smazat, na disku, tj. původní  originální 

zdroj, zůstává nedotčen!  

 

Je důležité si uvědomit, že klipy se při importu fyzicky 

nekopírují, nepřesunou ani nepřekódují. DaVinci Resolve je 

v tomto ohledu zcela nedestruktivní!!! 

Při prvním přetažení klipu z prohlížeče knihovny médií dolů do 

zásobníku se může objevit  okno s požadavkem na změnu projektu 

dle parametrů přesouvaného klipu. 
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Pokud zvolíte Change, nastaví se projekt  dle rozlišení a snímkové 

frekvence vybraného klipu.  

Pokud zvolíte Don´t change zůstane nastavení projektu tak, jak jste 

je nastavili před importem klipů, tj. beze změny. 

 

3.3 IMPORTOVÁNÍ ADRESÁŘŮ  

Místo výběru všech klipů jednotlivě, které chcete importovat a 

přidání všech do hlavního zásobníku, můžete importovat celou 

složku a automaticky vytvořit vlastní virtuální adresář  tzv. Bin. 

Prv. tlč. myši klikněte na požadovanou složku a vyberte 

z kontextového menu Add Folders and Subfolders into Media Pool 

(Create Bins).  

V zásobníku vytvoříte stejnou strukturu adresářů a všechny klipy 

obsažené ve složce se importují. 

 

3.4 RYCHLÉ SEZNÁMENÍ S OBSAHEM KLIPŮ  

Možná budete chtít po importu své klipy zkontrolovat, zvláště pokud 

upravujete projekt, který natočil někdo jiný a zatím jste se stopážemi 

neseznámili nebo uplynul velký časový odstup od natočení. 

Přejetím myši po miniatuře klipu uvidíte hrubý obsah klipu. 

➢ Přesuňte tedy ukazatel myši sem a tam po miniatuře, abyste 

rychle prošli klipem a viděli jeho hrubý náhled.  

Miniatury klipů v zásobníku zvětšíte či zmenšíte táhlem umístěném 

nad miniaturami.  
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➢ Pokud si chcete vytvořit na miniatuře 

svůj obrázkový náhled z klipu, který 

bude klip v náhledech lépe 

charakterizovat, najeďte myší na 

požadovaný frame a stiskněte Ctrl+P 

nebo přes prv. tlč. myši vyberte 

v kontextovém menu volbu  Set 

Poster Frame.  

➢ Klip od teď bude prezentován vámi vybraným 

obrázkem. 

➢ Pokud na klip kliknete myší, zobrazí se jeho obsah 

v přehrávači.  

➢ Stisknutím mezerníku zahájíte přehrávání klipu a 

dalším stisknutím mezerníku přehrávání zastavíte. 
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3.5 PROHLÍŽENÍ METADAT KLIPU  

Kromě zvukového a video obsahu mohou klipy 

obsahovat také informace tzv.  metadata, která 

popisují obsah vašich klipů.  

Metadata mohou mimo jiné identifikovat 

formát, snímkovou frekvenci a rozlišení.  

Některá metadata jsou automaticky přidána do 

klipu fotoaparátem či zvukovými záznamníky.  

Můžete také přidat vlastní metadata, například  

Keywords (klíčová slova), která můžete použít k 

efektivnější organizaci klipů v projektu. 

Můžete zobrazit metadata klipu a přidat další 

informace pomocí editoru metadat. 

V zásobníku klepněte na požadovaný klip a 

načtěte jej tímto do přehrávače. 

Podrobné informace o vybraném klipu se zobrazí 

v editoru metadat v pravém dolním rohu 

zásobníku médií. 

Pokud rozklikneme kontextovou nabídku okna 

Metadata, přes ikonu vpravo nahoře daného okna, můžeme zde 

vybrat a zobrazit libovolné množství informací k vybranému klipu. 

Každá kategorie v rozevírací nabídce obsahuje další pole a 

zaškrtávací políčka. 

Některá mohou zobrazovat metadata zadaná automaticky kamerou 

nebo jinými zařízeními, zatímco jiná pole umožňují přidat vlastní 

informace, které mohou být 

užitečné při organizaci vašich 

klipů.  

Pokud máte rozsáhlý projekt, 

věnujte této části pozornost, 

usnadní vám následně práci 

při třídění a identifikaci klipů. 

Např. klíčová slova můžete 

vkládat i u více klipů 

najednou. 

➢ Vyberte příslušné klipy, zvolte v kontextové nabídce volbu 

Shot–Scene a zadejte klíčové slovo do položky Keywords a 

vpravo dole uložte přes volbu Save. 
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4. ZÁLOŽKA CUT 

4.1 ZAČÍNÁME SE  ZÁLOŽKOU CUT  

Pokud jde o úpravy video a audio obsahu, neexistuje jediný 

univerzální postup. 

Proto má DaVinci Resolve dvě různá editační rozhraní, Cut a 

Edit.  

Nová záložka Cut  slouží k projektu, který je třeba rychle upravit a 

publikovat.  

Je ideální pro úpravy zpráv, videoblogy, online promo videa, 

vzdělávací obsah atd. 

Tradiční záložka pro úpravy Edit  obsahuje širší škálu funkcí.  

Můžete si pro střih vybrat kteroukoli ze záložek, podle toho, co je 

pro vaše potřeby nejvhodnější.  

Při práci můžete kdykoli mezi nimi přepínat. 

Záložka Cut odstraní zbytečné pracovní kroky a vše, co by vás mohlo 

zpomalit.  

Každé kliknutí nebo akce provedené na této záložce má přímý 

výsledek. Neexistují žádná nadbytečná kliknutí ani složitá nastavení.  

Záložka je koncipována tak, aby předvídala to, co chcete dělat, a 

pomáhá vám dostat se tam rychleji.  

Nejprve začněte spuštěním aplikace DaVinci Resolve, pokud 

již nemáte spuštěnu. 

Poklepáním na miniaturu Untitled Project - otevřete nový 

projekt.  

DaVinci Resolve otevře a zobrazí naposledy použitou záložku. 

V dolní části okna programu se proto klepnutím na tlačítko 

Cut  přepněte v případě potřeby na záložku Cut.  
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V levé horní oblasti je Media Pool (prohlížeč médií).  

To je místo, kde lze všechny klipy ve vašem projektu třídit, 

organizovat a kontrolovat.  

Při zahájení projektu importujete klipy do Media Pool pomocí 

tlačítek v levém horním rohu: 

➢ Import Media: Načte soubor, dle výběru.  

➢ Import Media Folder:  Načte soubory z vybrané 

složky včetně struktury složek. 

➢ Sync Clips: Sychronizuje vybrané klipy dle zvukové 

stopy či timecode. 

➢ Relink Media: Volba  pro opětovné propojení offline klipů 

usnadňuje hledání konkrétních chybějících klipů. 

• Kliknutím na tuto ikonu se otevře nové dialogové okno 

zobrazující svazky, ke kterým chybějící soubory původně 

patřily. Tyto informace pak můžete použít ke sledování 
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médií ve vašem souborovém systému, vyhledání 

konkrétního pevného disku.  

• Kliknutím na tlačítko Locate můžete 

znovu připojit chybějící klipy k novému 

umístění souboru podle vašeho výběru. 

• Pokud rychlé hledání zahájené tlačítky 

Locate nenalezne média, o kterých víte, 

že tam jsou, můžete zahájit hloubkové 

hledání na  disku kliknutím na tlačítko 

Disk Search. 

Tyto volby nahrazují práci v záložce Media.  

Pracovní postup obou záložek samozřejmě 

můžete kombinovat.   

Dále můžete řadit klipy přes ikonu seznamu, dle 

vybraných parametrů, například podle timecode, 

názvu klipu, použité kamery či času pořízení 

nahrávky atd.  

Můžete použít i volbu Ascending nebo 

Descending, tj. (řazení vzestupně či sestupně). 

 

 

 

4.2 BEZPEČNÁ OBLAST - SAFE AREA 

Safe area neboli bezpečná oblast pro 

přidanou grafiku, titulky či znázornění 

požadovaného poměru stran. 

Tato rozevírací nabídka je situována nad 

přehrávačem vlevo.  

Vodící linky či rámečky zapínáte či 

vypínáte poklikáním na příslušné volby.  

Na výběr máte různé poměry stran pro 

sociální média: 1:1, 4:5, 9:16, 1.91:1, 

16:9 či pro broadcast a film: 1.33, 1.66, 

1.77, 1.85, 2.35. 

Poslední nabídka je určena pro 

bezpečné umístění grafiky, titulků a umístění středového bodu. 

 



 

    

Cut 

- Interface 

4 

DAVINCI RESOLVE STUDIO 17 | ČESKÝ NÁVOD PRO ZAČÁTEČNÍKY 

4.3 PŘIDÁNÍ KLIPŮ NA ČASOVOU OSU  

Jakmile máte vybraná média  v zásobníku, můžete začít prohlížet 

klipy a vybrat ty, které chcete použít v projektu. 

Klipy můžete přehrávat ve větším přehrávači, poklepáním na ně, 

v zásobníku médií. 

Prohlížeč nyní zobrazuje klip se zvukovou stopou pod ním. 

Klip můžete přehrát stisknutím mezerníku nebo kliknutím na šipku 

přehrávání pod náhledem. 

U klipů můžete provést tzv. předvýběr, kdy lev. tlč. myši přidržíte 

okraj výběru a přetáhnete na požadované místo. 

To samé uděláte i na konci klipu.  

Existují i klávesy, které vám s tímto výběrem 

mohou pomoci a to klv. I (IN) a O (OUT).  

První klávesa vyznačí začátek výběru druhá 

klávesa konec výběru.  

Pokud se naučíte k tomu používat pro přehrávání klv.  J–K–L  (zpět–

stop–vpřed), bude vaše práce efektivnější a rychlejší. 

Dále můžete vícenásobně prstem poklepat na klv. J nebo L a změníte 

tak rychlost přehrávání zpět-vpřed, ve vybraném klipu.  

Pokud se chcete přesunout rychle a přesně do  vstupního či 

výstupního bodu výběru, použijte klv. zkratku Shift+I nebo Shift+O.  
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Ve výběru se můžete pohybovat i jen po jednotlivých obrázcích, tzv. 

framech. 

Použijte myš na ikoně „terčík se dvěma 

šipkami“ nebo na klávesnici  použijte 

klávesy šipek vlevo či vpravo. 

Při posuvu výběru vám prohlížeč nabízí 

detail začátku a konce záběru, pro lepší 

orientaci.  

Červená hlava přehrávání značí, kde začne případně přehrávání 

klipu, při jeho prohlížení. 

 

Pro provedeném výběru uchopte lev. tlč. myši obraz a přetáhněte 

výběr dolů na časovou osu. 
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5. ZÁLOŽKA EDIT 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.1 ÚVOD  

S importovaným a uspořádaným obsahem na záložce Media jste 

připraveni zahájit úpravy na záložce Edit. 

První krok při práci na  časové ose se nazývá hrubý střih.  

Cílem je umístit klipy v hrubém pořadí, ve kterém je budete 

chtít ve svém projektu.  

Je to ekvivalent skicování obrázku, spíše než jeho přesného kreslení.  
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Na rozdíl od záložky Cut, kde je nejdůležitějším požadavkem rychlé 

úpravy bez zbytečných okolků, je záložka Edit navržena pro 

komplexnější úpravy a za tímto účelem poskytuje více možností v 

řadě způsobů, jak můžete projekt upravit. 

 

5.2 VYTVOŘENÍ ČASOVÉ OSY  

Než budete moci začít s úpravami, musíte vytvořit časovou osu, do 

které umístíte klipy v pořadí, ve kterém je budete chtít použít.  

Projekty DaVinci Resolve mohou obsahovat jednu nebo více 

upravených časových os.  

Při experimentování s více verzemi časové osy může být užitečné 

duplikovat časovou osu výběrem v hl. menu Edit > Duplicate Current 

Timeline.  

Na rozdíl od záložky Cut můžete časové osy umístit do 

libovolného adresáře (Bin), nejen do hlavního adresáře 

(Master). 

Spusťte tedy program DaVinci Resolve, pokud tak již nemáte a 

přejděte na záložku Edit. 

Otevřete nový nebo již existující projekt a přejděte na 

Media Pool. 

Vytvořte nový adresář (Bin), klv. zkratka Ctrl+Shift+N nebo v hl. 

menu File > New Bin nebo přes prv. tlč. myši v Media Pool, a 

v kontextovém menu zvolte Add Bin. 

V novém adresáři přes  nabídku hl. menu File  > 

New Timeline nebo přes klv. zkr. Ctrl+N, 

vytvořte ve vašem projektu novou časovou osu. 
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Tu si můžete pojmenovat a založit tlč. Create.  

Založením časové osy ze změní i  vzhled časové osy v programu, 

respk. její záhlaví. 

 

Pokud před založením časové osy odškrtnete nabídku User Project 

Settings, můžete upravit další parametry projektu v záložkách 

General, Format, Monitor, Output, a to např. rozlišení videa, náhled 

videa, výstup atd. 
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5.3 PRVNÍ KROK ÚPRAV VIDEO PROJEKT U 

MEDIA POOL  -  PROHLÍŽEČ MÉDIÍ  

Velká část procesu úprav je výběr 

vašich snímků.  

Nevybíráte jen to, které klipy 

zahrnout do projektu; vybíráte 

také části klipů, které chcete 

použít.  

Přejdeme na část Media Pool, kde máte vybrány klipy, se kterými 

chceme v projektu pracovat.  

Jejich zobrazení můžeme ovlivnit a to tlačítky Metadata View, 

Thumbnail View, List View, které se nacházejí nad oknem Media 

Pool.  

Přepínáním mezi nimi volíme způsob zobrazení klipů.  

 

 

U miniatur můžete samozřejmě libovolně měnit jejich velikost 

zobrazení a to jezdcem umístěným v záhlaví okna Media Pool. 

 

 

V záhlaví máte i další možnost jak vyhledávat a třídit klipy a to ikonou 

„Lupy“, Selected Bins.  

Můžete používat i různé filtry řazení. 
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Další upřesňující informace pro 

zobrazení klipů vyvoláme 

kontextovým menu Option v záhlaví 

Media Pool, označené třemi tečkami 

(…).  

 

 

 

 

PLAYER PREVIEW - PŘEHRÁVAČ KLIPŮ  

Pokud tedy kliknutím lev. tlč. myši vyberete klip, zobrazí se nám 

v přehrávači, situovaném uprostřed nahoře. 

Vyvoláním kontextového menu Option přes ikonu třech teček (…), 

vpravo nahoře, si  můžeme zobrazit v obraze i audio stopu.  

Je to vhodné pro lepší přehlednost a možnost snáze nalézt příslušné 

místo pro střih.  

Jde o volbu Show Zoomed Audio Waveform, kterou zaškrtneme. 

Výběr záběru v klipu provádíme stejným způsobem jako na záložce 

Cut.  
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6. ZÁLOŽKA FUSION 

S DaVinci Resolve máte možnost vytvářet své vlastní vizuální 

efekty, takže můžete diváky přenést do zcela věrohodných 

magických světů! 

Výroba vizuálních efektů vyžaduje čas a cvičení.  

Ale jakmile s tím začnete, budete moci oživit prakticky jakékoliv 

video! 

Záložka Fusion v DaVinci Resolve obsahuje všechny nástroje, které 

potřebujete k vytváření vizuálních efektů a animované pohybové 

grafiky pomocí uzlů, místo vrstev.  

Budete to dělat tak, že propojíte nástroje dohromady, jako byste 

kombinovali stavební bloky a poté je připojíte do vývojového 

diagramu zpracování obrazu. 

Ve většině editačních systémů sestavíte hrubý sestřih projektu  na 

časové ose. 

Pokud potřebujete do projektu přidat kompozici nebo pohyblivou 

grafikou, exportujete snímky, otevřete jiný software, vše upravíte, 

importujete snímky a poté vše vrátíte zpět do časové osy.  

V DaVinci Resolve je vše jednoduší, prostě se přepnete na záložku 

Fusion, vytvoříte grafiku a vracíte se zpět na záložku Edit dokončit 

svůj projekt. 

 

6.1 ROZHRANÍ ZÁLOŽKY FUSION  

Stránka je rozdělena do čtyř hlavních sekcí. 

Monitory (přehrávače - Viewers) v horní části zobrazují kompozice, 

na kterých pracujete.  

Pod monitory je umístěn panel nástrojů pro nejčastěji používané 

efekty a nástroje. 

Dolní pracovní oblast, nazývaná editor uzlů (Nodes Editor), je 

srdcem záložky Fusion, kde vytváříte své efekty.  

Poslední panel je inspektor, který je situovaný vpravo.  
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Jde o editor klíčovacích snímků  a veškerých parametrů efektů a 

nástrojů.  

Editor uzlů dále sdílí prostor se Spline Editor a Keyframes Editor. 

Fusion nepoužívá časovou osu pro skládání nebo kompozici efektů. 

Místo toho používá strukturu (strom) uzlů, ve kterém je každý 

nástroj nebo efekt uzlem, jenž je znázorněn obdélníkovou ikonou v 

editoru uzlů. 

Uzly jsou spojeny ve stylu vývojového diagramu, díky kterému 

můžete snadno vidět celou strukturu kompozice a rychle provádět 

změny.  

Práce s uzly ve Fusion, pokud pochopíte tento princip pracovního 

postupu, je mnohem efektivnější než práce s řádky a hledáním 

různých podnabídek vnořených do vrstev a filtrů. 

Strom uzlů spojuje jeden uzel do druhého: jeden uzel aplikuje na 

obrázek efekt a poté jej předá jinému uzlu pro další postup nebo 

výstup. 
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PANEL NÁSTROJŮ ROZHRANÍ  

Na samém vrcholu záložky Fusion je panel nástrojů s tlačítky, které 

vám umožňují zobrazit a skrýt různé části uživatelského rozhraní 

záložky Fusion.  

Tlačítka se štítky označují, které části uživatelského rozhraní lze 

zobrazit nebo skrýt. 

Pokud kliknete prv. tlč. myši kdekoli na tomto panelu nástrojů, máte 

možnost zobrazit tento panel s textovými štítky nebo bez nich. 

➢ Media Pool: Zobrazí nebo skryje Media Pool, ze kterého 

můžete přetáhnout další klipy do editoru uzlů a použít je v 

kompozici záložky Fusion. 

➢ Effects Library: Zobrazí nebo skryje knihovnu všech 

nástrojů, které jsou k dispozici pro použití na záložce Fusion. 

Na ně můžete kliknout a přidat je za aktuálně vybraný uzel v 

editoru uzlů, nebo je můžete přetáhnout do libovolné části 

stromu uzlů.  

➢ Clips: Otevírá a zavírá časovou osu miniatur, která vám 

umožní procházet děj, vytvářet a spravovat více verzí videa 

a obnovit aktuální video. 

➢ Nodes: Zobrazí nebo skryje editor uzlů, kde vytváříte a 

upravujete své kompozice. 

➢ Spline: Otevírá a zavírá Spline Editor, kde můžete upravovat 

křivky, které interpolují animaci klíčovacích snímků, a 

upravit tak jejich načasování. Každý parametr s klíčovým 

snímkem se zobrazí hierarchicky v rámci efektu, v seznamu 

nalevo. 

➢ Keyframes: Zobrazí nebo skryje editor klíčovacích snímků, 

který zobrazuje každý uzel v kompozici Fusion jako vrstvu. 

Pomocí editoru klíčovacích snímků můžete upravit 

načasování klíčovacích snímků, které byly přidány k různým 

efektům v kompozici. Pomocí editoru klíčovacích snímků 

můžete také posunout relativní načasování klipů, které byly 

přidány na záložku Fusion, a také oříznout jejich body In a 

Out. Lze zobrazit a skrýt tabulku, ve které můžete numericky 

upravovat hodnoty klíčovacích snímků pro vybrané efekty. 

➢ Metadata: Zobrazí nebo skryje editor metadat, který vám 

umožní číst a upravovat dostupná metadata klipu. 

➢ Inspector: Zobrazí nebo skryje Inspector, který vám zobrazí 

všechny editovatelné parametry a ovládací prvky, které 

odpovídají vybraným uzlům v editoru uzlů. Můžete zobrazit 

parametry pro více uzlů najednou a dokonce připnout 

parametry uzlů, na kterých musíte pokračovat v úpravách, i 

když tyto uzly nejsou vybrány. 
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VIEWERS – MONITORY (PŘEHRÁVAČE)  

Oblast monitorů lze nastavit tak, aby zobrazovala jeden nebo 

dva přehrávače v horní části záložky  Fusion.  

To se nastavuje pomocí tlačítka přehrávače vpravo nahoře v 

záhlaví přehrávače. 

Každý přehrávač může zobrazit výstup jednoho uzlu odkudkoli 

ze stromu uzlů.  

To usnadňuje načtení samostatných uzlů do 

každého přehrávače pro srovnání.  

Například můžete načíst Text do levého 

přehrávače a MediaOut do pravého 

přehrávače, abyste viděli současně 

upravovaný efekt nebo uzel a konečný 

výsledek. 

Dva monitory vám umožní upravit uzel v jednom, 

zatímco v druhém uvidíte jeho vliv na celkovou 

kompozici. 

Každý prohlížeč obvykle zobrazuje 2D uzly z vaší 

kompozice jako jeden obrázek.  

Když si však prohlížíte 3D uzel, máte možnost 

nastavit tento prohlížeč na jeden z několika 3D 

pohledů, včetně perspektivního pohledu. 

 

ZOOMOVÁNÍ A POHYB V OBRAZE  

➢ Můžete též zoomovat obraz  v přehrávačích. Tyto způsoby také 

fungují s editorem uzlů, editorem spline a editorem keyframes. 

➢ Pohyb obrazem v přehrávačích provádíte středním kolečkem 

myši. Obraz se posouvá nahoru a dolů. 

➢ Přidržíte-li střední rolovací kolečko myši, můžete posunovat 

obrazem do libovolného směru. 

➢ Podržíte-li Ctrl+rolováním kolečka myši zoomuje v obraze. To 

lze i na num. klávesnici klv.  + (plus) a – (mínus).  

➢ Pokud chcete zoomovat v jemnějších krocích, zároveň podržte 

levé tlč. myši a střední tlč. myši a pohybem myši vlevo-vpravo 

zoomujete  v obraze.  

➢ V neposlední řadě můžete podržet střední tlč. myši a kliknout 

buď lev. tlč. myši nebo prv. tlč. myši. Dojde v krocích k zoomu či 

odzoomování. 

➢ Kdo umí hrát na klavír, má s  tímto prstokladem méně problémů 

:D 
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• Uvedené možnosti jsou matoucí, dokud 

si je nevštípíte do hlavy a nestane se 

z jejich používání rutina. Můžete proto 

využít i kontextového menu a  několika 

zkratek. 

 

➢ Prv. tlč. myši vyberte nabídku Scale a 

z podnabídky další vhodnou možnost, dle 

vaší preference. 

 

 

NASTAVENÍ PŘEHRÁVAČŮ - VIEWERS 

 

 

 

Série tlačítek a rozbalovacích nabídek v záhlaví přehrávače poskytuje 

několik rychlých způsobů přizpůsobení zobrazení přehrávače. 

➢ Zoom menu: Umožňuje vám přiblížit obrázek v přehrávači, 

abyste získali bližší pohled, nebo oddálit, abyste získali více 

prostoru kolem okrajů rámečku pro rotační kopírování nebo 

umístění různých vrstev. 

➢ Split Wipe button and A/B Buffer menu: 

Ve skutečnosti můžete načíst vizuálně dva 

uzly do jednoho prohlížeče pomocí A/B 

vyrovnávacích pamětí daného 

přehrávače. A to výběrem bufferu z 

nabídky a přetažením uzlu do prohlížeče. 

Zapnutí tlačítka  zobrazí rozdělené obrazy 

mezi dvěma vyrovnávacími paměťmi, 

které lze přetáhnout doleva nebo 

doprava pomocí dělící linky ovládacího 

prvku na obrazovce, nebo otočit přetažením kdekoli na dělicí 

čáře.  

➢ SubView type: Zapne nebo vypne „doplňky“ přehrávače v 

malém podokně, které lze použít k náhledu obrázků různými 

způsoby. 

➢ Node name: Název aktuálně prohlíženého uzlu je zobrazen ve 

středu záhlaví přehrávače. 

➢ RoI controls: Kliknutím na ikonu povolíte nebo zakážete 

omezení RoI v přehrávači, zatímco pomocí nabídky můžete 

vybrat oblast RoI. Oblast zájmu (RoI) vám umožňuje definovat 

oblast přehrávače, ve které se pixely skutečně musí vypočítat. 

Když se uzel vykreslí, protíná aktuální RoI s aktuální doménou 
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definice (DoD), aby určil, jaké pixely by měly být ovlivněny. 

Pokud je tato možnost povolena, můžete umístit obdélník, který 

omezí výpočet na malou oblast obrazu, což může výrazně 

zrychlit výkon při práci na velmi vysokém rozlišení nebo složitých 

kompozicích. Automaticky (výchozí) nastaví oblast na cokoli, co 

je viditelné na aktuální úrovni přiblížení / posunutí v přehrávači.  

➢ Color controls: Umožňuje vybrat, které barevné nebo obrazové 

kanály se mají v přehrávači zobrazit. Kliknutím na ikonu 

přepínáte mezi Color (RGB) a Alpha. Klv. A vypínáte či zapínáte 

zobrazení Alpha kanálu.  

➢ Viewer LUT: Kliknutím na ikonu zapnete nebo vypnete zobrazení 

LUT, zatímco v nabídce si můžete vybrat, který z mnoha 

dostupných převodů barevného prostoru se má použít. 

➢ Nabídka Option (…): Tato nabídka obsahuje různá nastavení 

týkající se přehrávače na záložce Fusion. 

• Checker Underlay: Přepíná šachovnicový podklad, který 

usnadňuje zobrazení oblasti průhlednosti. 

• Show Controls: Přepíná všechny ovládací prvky na 

obrazovce, které jsou viditelné pro aktuálně vybraný 

uzel. 

 

OVLÁDACÍ PRVKY PRAVÍTKA PŘEHRÁVAČE – TIME RULER 

Time Ruler (Časové pravítko), umístěné pod oblastí přehrávače, 

ukazuje rozsah snímků aktuálního klipu nebo kompozice. 

Doba trvání tohoto rozsahu však závisí na tom, co je aktuálně 

vybráno na časové ose. 

Pokud jste vybrali přímo klip, pak časové pravítko zobrazí všechny 

zdrojové snímky pro tento klip a aktuální body In a Out pro tento klip 

definují rozsah renderování nebo rozsah použitý na časové ose.  

Všechny snímky mimo tento rozsah tvoří materiál „před“ a „za“ 

tímto klipem, které se v upravené časové ose nepoužívají. 

Pokud jste vybrali Fusion Clip nebo Compound Clip, pak „pracovní 

rozsah “odráží celou dobu trvání tohoto klipu. 

Přehrávací hlava v nástroji Time Ruler označuje aktuálně zobrazený 

snímek.  

Kliknutím kdekoli v rámci Time Ruler přeskočíte s kurzorem na daný 

snímek a přetažením v rámci Time Ruler přetáhnete přehrávací 

hlavu v rámci dostupné doby trvání daného klipu nebo kompozice. 
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7. ZÁLOŽKA COLOR 

Než se pustíte do technické stránky korekce barev a naučíte se, 

jak fungují výkonné nástroje pro korekci barev v DaVinci 

Resolve, je důležité věnovat chvíli pochopení korekce barev a 

jejich kreativních možností. 

Pro správně barevné korekce nestačí pouze to, že pochopíte 

rozhraní záložky Color a naučíte se  správně ovládat jednotlivé 

ovládací prvky. 

Je to sama o sobě velmi kreativní dovednost.  

Stejně jako dobrý editor dokáže vyprávět příběh a do  něho vnášet 

drama, vyvolává kolorista v divákovi emoce pomocí vizuální 

manipulace s obrazem.  

I když může chvíli trvat, než se naučíte jak být dobrým koloristou, 

stejně jako u všech kreativních dovedností to nebude nudné, 

protože se něco nového naučíte o objevíte nové věci, které můžete 

prozkoumat. 

 

➢ Kontinuita neboli plynulost: Ani ve velkorozpočtových 

filmech nejsou všechny záběry konzistentní, ať už co do 

expozice, nebo vyvážení barev. Úkolem koloristy je všechny 

tyto proměnné – barvy a tóny – sjednotit napříč celým 

filmem. 

 

➢ Separace neboli důraz na  konkrétní prvek: Filmaři vytvářejí 

hloubku záběru prostřednictvím kompozice a světla. 

Barevná korekce dokáže totéž prostřednictvím barvy, např. 

stejně jako objektiv izolovat subjekt. 

 

 

➢ Barevnost: I prostřednictvím správných barev lze ovlivnit 

divákovy emoce, pomoct mu porozumět příběhu a zároveň 

dodat filmu atmosféru. 

 

7.1 ROZHRANÍ ZÁLOŽKY COLOR  

Záložka Color  je rozdělena do sedmi hlavních oblastí, které společně 

vytvářejí pracovní prostředí této záložky.  
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Pokud používáte DaVinci Resolve na displeji počítače s rozlišením 

nižším než 1920 x 1080, některé panely a tlačítka budou sloučeny a 

nebudou vypadat přesně jako obrázky v tomto textu. 

Panel nástrojů rozhraní 

V horní části záložky Color je panel nástrojů s tlačítky, která vám 

umožňují zobrazit a skrýt různé části uživatelského rozhraní.  

Tato tlačítka jsou zleva doprava: 

 

 

 

 

Středové panely poskytují 

přístup ke křivkám, 

ovládacím prvkům 

Window, trackingu a 

klíčování 

Galerie obsahuje uložené 

úpravy, které můžete 

zkopírovat do jiných klipů na 

časové ose 
 

 

Panely vlevo obsahují primární 

úpravy barev, kontrastu a 

zpracování obrázků RAW 

V oblasti vpravo dole může být 

zobrazen editor klíčových snímků, 

scopes nebo zobrazení dalších 

informací 
Časová osa je rozdělena na 

miniatury a mini-časovou osu 
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➢ Gallery: Otevře a zavře panel Galerie. 

➢ LUTs: Otevře a zavře obrazové šablony pro klipy 

➢ Media Pool: Správa médií v projektu 

 

➢ Timeline:  Otevírá a zavírá mini-časovou osu. 

➢ Clips: Otevírá a zavírá časovou osu miniatur. 

➢ Nodes: Otevře a zavře editor uzlů. 

➢ OpenFX: Otevírá a zavírá panel OpenFX. 

➢ Lightbox: Otevírá a zavírá Lightbox. 

 

PŘEHRÁVAČ 

Přehrávač zobrazuje snímek na aktuální pozici 

přehrávací hlavy na časové ose.  

V horní části přehrávače je záhlaví, které 

zobrazuje název projektu a časové osy, stejně jako 

zobrazení časového kódu prohlížeče, které ve 

výchozím nastavení zobrazuje zdrojový časový 

kód každého klipu.  

Název časové osy je také otevírací nabídka, která 

umožňuje přepnout na jakoukoli jinou časovou 

osu v projektu.  

Jezdec s ukazatelem průběhu klipu pod přehrávačem vám umožňuje 

táhnout přehrávací hlavu přes celou délku klipu.  

Ovládací prvky pod přehrávačem umožňují ovládat přehrávání.  

Panel nástrojů v horní části poskytuje ovládací prvky, kterými se řídí 

velikost zobrazení obrazu, rozdělení obrazovky,  zobrazení 

zvýraznění atd. 

Přehrávač můžete také přepnout do jednoho ze tří alternativních 

režimů tak, aby bylo možné při práci vidět větší náhled. 

Všechny tři z těchto režimů jsou k dispozici v podnabídce hl. menu 

Workspace > Viewer Mode submenu.  

Enhanced Viewer: (klv. zkr. Alt+F, zapnout/vypnout) skryje vše 

nalevo a napravo od přehrávače, což vám poskytne velkou pracovní 

plochu pro práci, jako je maskování a rotoscoping, přičemž panely 

zůstanou viditelné. 

Full Screen Viewer: (klv. zkr. Shift+F, zapnout/vypnout) je k dispozici 

proto, aby poskytoval více pracovního prostoru pro úkoly, jako je 

umísťování oken a rotoscoping.  
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Přehrávač na celou obrazovku vám také umožňuje zobrazit panel 

OpenFX v plné výšce a můžete také zapnout a vypnout editor 

uzlů. 

Cinema Viewer: (klv.  P, zapnout/vypnout) rozšiřuje přehrávač 

tak, aby vyplnil celý monitor vaší pracovní stanice. 

To se hodí v případě, pokud chcete přehrát aktuální časovou osu na 

celou plochu monitoru bez rušení.  

Pokud přesunete ukazatel myši nad obraz, zobrazí 

se ovládací prvky přenosu a ovládací lišta, která 

vám umožní ovládat přehrávání.  

U tohoto typu zobrazení můžete vyvoláním 

kontextové nabídky prv. tlč. myši a zapnout volby 

zobrazení scopes  a přizpůsobit jejich překrytí a 

umístění. 

 

GALERIE 

Galerie (Gallery) slouží pro ukládání statických 

snímků, které slouží jako reference a tzv. grades 

(barevných úprav), které můžete kopírovat.  

Statické snímky a grades jsou uloženy společně.  

Tlačítkem Gallery otevřete prohlížeč, ve kterém 

můžete statické snímky organizovat.  

Pod tlačítkem Gallery můžete otevřít Memories, kam můžete 

ukládat  grades a ty pak použít pomocí ovládacího panelu nebo 

klávesových zkratek. 

 

PROHLÍŽEČ LUT  

Co je to LUT ? 

Look Up Table, nebo-li LUT, je v podstatě digitální 

soubor, který transformuje barvu a tón vašeho 

obrazu.  

Používá se, když je nezbytné převést barvy a 

podrobnosti ve zdrojovém souboru do nového 

cílového souboru.  

LUT můžete například použít jako šablonu 

předpřipraveného barevného podání obrazu.  
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LUT v zásadě transformuje tón a barvu na základě nastavení 

zvolených tvůrcem LUT. 

Prohlížeč LUT poskytuje centralizovanou oblast pro procházení a 

náhled všech nainstalovaných LUTs na vaší pracovní stanici.  

Všechny LUTs se zobrazují na postranním panelu podle kategorií. 

Ve výchozím nastavení se všechny LUTs zobrazují s testovací 

miniaturou, která poskytuje náhled efektu této LUT.  

Můžete však získat živý náhled toho, jak vypadá aktuální klip s touto 

LUT, a to tak, že přejedete kurzorem myši nad konkrétní miniaturou 

LUT. 

Metody práce s prohlížečem LUT: 

➢ Chcete-li zobrazit LUT v jakékoli kategorii: Klepnutím na 

kategorii LUT ji vyberte v postranním panelu a LUTs se zobrazí 

v prohlížeči. 

➢ Chcete-li, aby se LUT stala oblíbenou: Umístěte kurzor 

myši nad LUT a klikněte na znak hvězdy v pravém horním 

rohu miniatury, nebo klikněte prv. tlč. myši na libovolnou 

LUT a vyberte Add To Favorites  ( Přidat do oblíbených). 

Tato LUT se poté zobrazí, když vyberete kategorii 

Favorites. 

➢ Chcete-li vyhledat nebo filtrovat konkrétní LUT: Otevřete ikonu 

„lupy“, poté se otevře vyhledávací pole a zadejte text, který 

identifikuje LUT, kterou hledáte. 

➢ Chcete-li třídit LUT v zobrazení miniatur: Klikněte na 

rozbalovací nabídku Thumbnail Sort (Třídění miniatur) a 

vyberte, podle kterých kritérií chcete LUT seřadit. Možnosti jsou 

Filename, Type, Relative Path, File Path, Usage, Date Modified  

(Název souboru, typ, relativní cesta, cesta k souboru, použití, 

datum změny). K dispozici jsou také možnosti pro vzestupné a 

sestupné režimy řazení. 

➢ Třídění LUT v zobrazení sloupců: Kliknutím na záhlaví sloupce 

seřadíte podle daného sloupce. Opakovaným kliknutím na 

záhlaví můžete přepínat mezi vzestupným a sestupným 

režimem. 

➢ Chcete-li aktualizovat miniaturu LUT s obrázkem z klipu: 

Vyberte klip a snímek, který chcete použít jako novou miniaturu 

pro konkrétní LUT, poté klepněte prv. tlč. myši na danou LUT a 

vyberte Update Thumbnail With Timeline Frame  (Aktualizovat 

miniaturu pomocí časové osy). 

➢ Chcete-li obnovit miniaturu LUT pro použití standardní 

miniatury: Klikněte prv. tlč. myši na LUT a zvolte Reset 

Thumbnail  (Obnovit miniaturu), abyste se vrátili k používání 

standardního testovacího obrázku. 
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8. ZÁLOŽKA FAIRLIGHT 

Proč profesionální produkce vynakládá tolik času, talentu a 

peněz, aby vytvořila perfektní soundtracky?  

Odpověď je, že vysoce kvalitní zvuk je pro vizuální vyprávění 

nezbytný a často jde o rozdíl mezi amatérskou a profesionální 

produkcí. 

 

8.1 ROZHRANÍ ZÁLOŽKY FAIRLIGHT  

Otevřete si svůj projekt a přejděte na záložku Fairlight, klv. zkr. 

Shift+7. 

I když se rozhraní může zdát jako jedna velká časová osa, záložka 

Fairlight je ve skutečnosti rozdělena do čtyř částí. 
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Vaše aktuální časová osa - se stejnými barevně odlišenými stopami, 

značkami a úrovněmi zvuku, které jste prohlíželi na záložce Edit je 

nyní k dispozici na záložce Fairlight. 

Vypadá to jinak, protože záložka Fairlight je optimalizována pro 

vícekanálové nahrávání zvuku, úpravy, mixování a sladění.  

Jak vidíte, výchozí rozložení je zjednodušené, aby zobrazovalo pouze 

zvukovou časovou osu.  

Na panelu Interface toolbar  (Rozhraní nástrojů) však můžete panely 

otevírat podle potřeby.  

Ve výchozím nastavení jsou Media Pool, Viewer, Audiometers a 

Mixer skryty. 

 

PANEL NÁSTROJŮ ROZHRANÍ 

 

 

➢ Media Pool: Zobrazí a skryje Media Pool, ze kterého můžete 

upravovat zvukové klipy na časové ose. 

➢ Effects Library: Otevře panel Audio FX v Effects Library 

(Knihovně efektů), ze kterého můžete použít VST a další zvukové 

efekty na klipy na časové ose. 

➢ Index: Zobrazí a skryje rejstřík a jeho panely Tracks a Markers  

(Stopy a značky). Panel Tracks vám umožňuje spravovat stopy 

na časové ose, zobrazovat a skrývat ty, s kterými chcete 

pracovat. Panel Markers  vám umožňuje zobrazit všechny 

značky na časové ose spolu s přidruženými daty, takže je snadné 

procházet všechny značky najednou a rychle najít potřebné 

informace.  

➢ Mixer: Zobrazí a skryje Mixer napravo od časové osy, který vám 

umožní upravit různé efekty a úrovně spojené s každou stopou 

časové osy, aby se vytvořil harmonický mix. 

➢ Meters: Zobrazí a skryje měřicí audio monitory a přehrávač v 

horní části záložky Fairlight. 

➢ Inspector: Zobrazí a skryje nabídku Inspector, ve kterém můžete 

upravovat různé atributy klipu. 

➢ Metadata: Zobrazí a skryje info - metadata klipu. 
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ZOBRAZENÍ, KTERÝ PANEL JE VYBRANÝ 

Kdykoli kliknete někam na rozhraní DaVinci Resolve pomocí 

ukazatele myši, dáte tomuto panelu prioritu.  

Tento panel tak používá konkrétní klávesové zkratky, které mají 

konkrétní dopad v tomto panelu, přitom jinde mají funkci rozdílnou.  

Na horním okraji se zobrazí zvýraznění, které vám ukáže, jaký panel 

má prioritu.  

Podle potřeby můžete přepnout prioritu na jinou část. 

Pokud chcete toto zvýraznění zobrazit, a pomoci si tak v orientaci, 

přejděte do uživatelského rozhraní přes hl. menu DaVinic Resolve > 

Preferences, vyberte nahoře záložku User, vlevo pak panel UI 

Settings.  

Zaklikněte volbu   Show focus indicators in the User Interface, která 

umožňuje povolit nebo zakázat grafickou linku v horní části každého 

panelu. 

 

ČASOVÁ OSA ZVUKU 

Srdce záložky Fairlight je časová osa zvuku, která prezentuje zvukové 

kanály a stopy jinak než záložka Edit, a to ve formátu jednoho kanálu 

na stopu, který je optimalizován pro mixování a sladění zvuku.  

Časovou osu záložky Fairlight nelze uzavřít. 
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➢ Ovládací prvky na časové ose zvuku 

• Pole časového kódu a tlačítka Range: Čtyři pole 

časového kódu zobrazují aktuální hodnotu 

časového kódu odpovídající poloze červeného 

přehrávacího kurzoru (úplně nahoře), bodu Range 

In, bodu Range Out a trvání Range (Rozsah). 

Kliknutím na tlačítka Range In a Range Out 

(nalevo od polí časového kódu) nastavíte tyto body a 

jejich odpovídající hodnotu časového kódu. 

➢ Ovládací prvky přehrávání:  

• Lišta nad horní částí časové osy 

obsahuje ovládací prvky 

přehrávání zvuku specifické pro 

záložku Fairlight, které se liší od těch, které se nacházejí 

na záložce  Media, Edit, Color a Deliver a to díky 

zahrnutí volby záznamu. Patří mezi ně Fast Reverse, 

Fast Forward, Play Forward, Stop, Record a Loop. 

➢ Panel nástrojů Automatizace: 

• Kliknutím na tlačítko Automation se otevře sekundární 

panel nástrojů se všemi ovládacími prvky, které 

potřebujete ke konfiguraci záznamu automatizace 

mixéru. 

 

 

 

➢ Monitorovací ovládací prvky: 

• Vpravo od prvků přehrávání vám sada tří 

monitorovacích ovládacích prvků umožňuje 

rychle ovládat výstupní hlasitost mixu. Tlačítko   

Enable/Disable: (Povolit/Zakázat) zvuk 

umožňuje ztlumit přehrávání zvuku, zatímco 

posuvník umožňuje změnit hlasitost a tlačítko 

DIM vám umožňuje dočasně potlačit výstup sledované 

hlasitosti. Příkazy Dim a Mute jsou k dispozici také z 

nabídky Fairlight. 

➢ Pravítko časové osy: 

• Timeline Ruler: (Pravítko časové osy) zobrazuje časový 

kód projektu. Přehrávací hlava označuje aktuální snímek 

a vzorek, kde pracujete na časové ose a přehrávací hlava 

má úchyt, který se zobrazuje v pravítku časové osy. 

Tažením v pravítku časové osy se 

přehrávací hlava přesune. Když přidáte 

značky na časovou osu, tak se tyto značky 

objeví také v pravítku časové osy. 

➢ Playhead: (Přehrávací hlava) ukazuje aktuální snímek a 

poskytuje vizuální představu o tom, kde se právě nacházíte. 
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➢ Audio tracks: Záložka Fairlight 

podporuje více zvukových stop a každá 

zvuková stopa může obsahovat více 

kanálů. Například mapování stereo, 

5.1, 7.1, nebo adaptivní (1–24 kanálů). 

Všechny zvukové klipy, které byly 

přidány na časovou osu, se zobrazují 

jednotlivě ve stopě, přičemž 

zaznamenané kanály v každém klipu 

zabírají tolik kanálů stopy, kolik jich 

dotyčný klip obsahuje. Vlevo od každé stopy je oblast 

záhlaví, které obsahuje řadu ovládacích prvků. 

➢ Track header: (Záhlaví stop) obsahuje různé ovládací 

prvky pro výběr, zamykání/odemykání a 

sólo/ztlumení stop. Každé záhlaví stopy také uvádí, 

kolik klipů se na dané stopě nachází. Záhlaví stopy 

obsahuje následující ovládací prvky, zleva doprava: 

 

• Track number: Udává čísla jednotlivých stop. 

• Track name: Každá stopa má jako výchozí název číslo 

stopy. Například Audio 1. To můžete změnit kliknutí na 

název a upravit dle vašich představ. Můžete například 

přejmenovat každou stopu podle typu zvuku, který na ní 

upravujete. Tyto názvy skladeb se také používají k 

identifikaci kanálu každé stopy ve směšovači uprostřed 

každého pruhu kanálu (číslo stopy každého pruhu 

kanálu se zobrazuje současně nahoře). 

• Audio channel type indicator: Zvukové stopy také 

ukazují, kterou konfiguraci kanálu tato stopa používá s 

uvedením počtu kanálů pro mono, stereo (2.0), 5.1, 7.1 

a adaptive.  

• Lock Track button: Světle šedá při zapnutí, 

tmavě šedá při vypnutí. Když je stopa 

uzamčena, nelze klipy nahrazovat, 

přesouvat ani jinak upravovat. 

• Arm button: Toto tlačítko aktivuje 

nahrávání na danou stopu. 

• Solo button: Deaktivuje všechny ostatní 

stopy kromě aktuální, což vám umožní 

rychle slyšet jednu stopu samostatně. To 

ovlivní výstup, takže pokud je jedna nebo 

více stop sólo, ztlumené stopy nebudou 

slyšet ani vidět na audio metru. 

• Mute button: Dočasně deaktivuje zvuk na této stopě, 

takže není ani monitorován, ani není na výstupu. 

Ovlivňuje tedy výstup, takže pokud je jedna nebo více 

stop ztlumených, nebudou slyšet ani vidět na audio 

metru. 
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9. ZÁLOŽKA DELIVER 

9.1 VÝSTUP POMOCÍ RYCHLÉHO EXPORTU – QUICK 

EXPORT 

Ne každá situace vyžaduje 

složité nastavení výstupu.  

Pokud potřebujete rychle 

exportovat projekt a 

rozšířená nastavení záložky 

Deliver nejsou nutná, 

můžete zvolit v hl. menu 

volbu File > Quick Export… 

a použít jednu z různých předvoleb k exportu vašeho výstupu z 

libovolné záložky DaVinci Resolve.  

Můžete dokonce použít Quick Export  k exportu a nahrání 

vašeho projektu do jedné z podporovaných služeb pro sdílení 

videa, YouTube, Vimeo a Twitter. 

Do okna Quick Export na panelu Render Settings můžete také 

přidat vlastní předvolby. 

 

POUŽITÍ RYCHLÉHO EXPORTU: 

➢ Na záložce Cut, Edit, Fusion nebo Color,  

časová osa  - výběr In (klv. I) a Out (klv. O) a 

vyberte rozsah aktuálního projektu, který 

chcete exportovat. Pokud nebyly nastaveny 

žádné vstupní nebo výstupní body časové 

osy, bude exportována celá časová osa. 

Zrušení výběru In-Out na časové ose 

provedete  klv. zkr. Alt+X. 

➢ Vyberte File > Quick Export… 

• V horním řádku ikon v dialogu Rychlý export 

vyberte předvolbu, kterou chcete použít, a 

klikněte na Export. 

• Vyberte umístění adresáře,  pomocí 

dialogového okna exportu zadejte název souboru a poté 

klikněte na Save. Zobrazí se dialogové okno s 

indikátorem průběhu, které vás informuje o tom jak 

dlouho bude export trvat. 
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PŘIZPŮSOBENÍ RYCHLÉHO EXPORTU: 

➢ Otevřete záložku Deliver. 

➢ Vytvořte předvolbu (nastavte si výstup dle vašich 

preferencí, rozlišení, kodek atd.), kterou chcete přidat na 

panel Render Settings. 

➢ Klikněte na nabídku Option (…) - Save As New Preset a 

uložte si svoje nastavení do šablony, kterou si vhodně 

pojmenujte. 

➢ Klikněte na nabídku Option (…) -  Quick Exports, otevře se 

další podnabídka. Zde vyberte šablonu, kterou chcete 

přidat.  

➢ Svou vlastní předvolbu můžete také odstranit z okna Quick 

Exports, volbou nabídka Option (…) - položka  Delete Current 

Preset 

 

 

 

 

 

 

 

9.2 OKNO ZÁLOŽKY DELIVER  
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PANEL NÁSTROJŮ ROZHRANÍ  

V horní části záložky Deliver je panel nástrojů s tlačítky, která vám 

umožňují zobrazit a skrýt různé části uživatelského rozhraní.  

Tato tlačítka jsou zleva doprava: 

➢ Delivery full/half height tlačítko: Umožňuje nastavit panel 

Render Settings tak, aby zabral celou výšku vašeho displeje, 

pokud potřebujete více plochy pro procházení různými 

nastaveními exportu, na úkor užší časové osy. 

➢ Render Settings: Tento panel obsahuje seznam všech nastavení 

výstupu (Render), která jsou k dispozici pro konfiguraci úloh 

výstupu v DaVinci Resolve. Ve výchozím nastavení se zobrazí 

krátký seznam, ale další možnosti jsou k dispozici kliknutím na 

Advanced Settings (Pokročilé nastavení) 

➢ Tape: Aktivuje záložku Deliver do režimu výstupu na pásku. 

➢ Clips: Skryje nebo zobrazí časovou osu miniatur nad časovou 

osou záložky Deliver 

• Render Queue: Seznam všech úloh, které jste nastavili k 

výstupu v aktuálním projektu. Dříve vypočítané úlohy 

zůstanou ve frontě, pro vaši referenci nebo pro opětovné 

použití výstupu těchto úloh, pokud je z fronty ručně 

neodstraníte. 

• Render Queue full/half height button: Umožňuje nastavit 

Render Queue tak, aby zabírala celou výšku vašeho displeje, 

pokud potřebujete více plochy pro výpis úloh exportu na 

úkor užší časové osy. 

 

RENDER SOUBORŮ VS. VÝSTUP NA PÁSKU 

Protože záložka Deliver má dvě funkce, můžete pomocí tlačítka Tape 

(Páska)  určit, zda renderujete pouze soubory nebo provedete 

výstup na pásku.  

Tímto způsobem nahradíte ovládací prvky v prohlížeči páskovými 

ovládacími prvky. 

 

NASTAVENÍ RENDERU (VÝSTUPU) 

Nastavení Render (Výstupu) obsahuje přizpůsobitelná nastavení, 

která určují, jak se média z DaVinci Resolve vypočítají.  

Pokud používáte možnost Tape, tato nastavení jsou deaktivována. 
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10. KLÁVESOVÉ ZKRATKY DAVINCI RESOLVE 


